MS EXCEL

A spreadsheet is essentially a matrix of rows and columns.
Consider a sheet of paper on which horizontal and vertical lines are
drawn to yield a rectangular grid. The grid namely a cell, is the result
of the intersection of a row with a column. Such a structure is called a
Spreadsheet.

A spreadsheet package contains electronic equivalent of a pen,
an eraser and large sheet of paper with vertical and horizontal lines to
give rows and columns. The cursor position uniquely shown in dark
mode indicates where the pen is currently pointing. We can enter text
or numbers at any position on the worksheet. We can enter a formula
in a cell where we want to perform a calculation and results are to be
displayed. A powerful recalculation facility jumps into action each time
we update the cell contents with new data.

MS-Excel is the most powerful spreadsheet package brought by
Microsoft. The three main components of this package are

% Electronic spreadsheet
% Database management
% Generation of Charts.

Each workbook provides 3 worksheets with facility to increase the
number of sheets. Each sheet provides 256 columns and 65536 rows
to work with. Though the spreadsheet packages were originally
designed for accountants, they have become popular with almost
everyone working with figures. Sales executives, book-keepers,
officers, students, research scholars, investors bankers etc, almost any
one find some form of application for it.

You will learn the following features at the end of this section.

% Starting Excel 2003

% Using Help

% Workbook Management
% Cursor Management

% Manipulating Data
+

Using Formulae and Functions
» Formatting Spreadsheet
Printing and Layout
» Creating Charts and Graphs
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Starting Excel 2003

% Switch on your computer and click on the Start button at the
bottom left of the screen.

% Move the mouse pointer to Programs, then across to
Microsoft Excel, then click on Excel as shown in this screen.
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% When you open Excel a screen similar to this will appear
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Parts of Excel Window

< The options shown below is called as Menu Bar

| Eile Edit View Insert Format Tooks Data Window Help

< The collection of icons for common operations shown below
is called as Standard Tool Bar
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TOOLBARS AND THE ICONS

Standard Toolbar

QAN P o -0,

DFEs SRY s BT - -

MNew —————————n Open
Creates a new blank file. Opens or finds afile.
Alfernative: File — New Alfernafive: File — Open
Shortout — Ctel + N & | Shortaut— Ctrl + 0O
Save | —H E-Mail
Saves the active file. Sends conterts of the current worksheet as
Alternafive: File — Save | body of the e-mail message
Shorfeut — Clel +8 @
&
Print / —
Prints the active file using current defaults.
Alfernative: File — Print
Shorfauf — Cttl +P
Print Preview - Spelling
Displays full pages as they ate printed. & Checks the spelling in the active file.
Alfernafive: File — Print Preview — Alfernafive: Tools — Spelling and
Shorfouf — Ctrl +F2 Grammer
o Shortcut — F7
Cut
Cuts the selection and puts it on the & Past
Cllphoa.t_d ' . Inserts the Clipboard contents at the
Alfernafive: Edit — Cut - i . .
Shorfout = Ctrl + X f— MR Doty
Aifernafive: Edit — Past
Shorfeuf — Ctel + V
Copy ; :
Copies the selection and puts it on the e Copies theﬁ:n:?:’:;?;::s:decﬁm i
clipboard,
, - ified location,
Alternafive: Edit — Copy <t specifie .
il oA | Sorteut > Cra + i + ¢
Redo
Und ) Ji
R . s Reverses the action of the Undo command.
everses certain commands, ©
Alteriative-Edd <> Undo Alfernafive: Edit — Repeat
Shortaut — Ctel +2 Ol — smorteut > cut +v
Insert Hyperlink S emd Auto .s_m;l S
Displays the destination object, document a T muﬁ a}?::'t?:?&s?;;ggs;’:he r;lge -
of page. - '
AIrErEatz‘ve‘ Edit — Repeat cells to be added. If the suggested range is
Shortcut _>' Ctel + K 5 incorrect, drag through the range you want,
=i and then press ENTER
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o Paparth Adds b Atuo ﬁl ith th
Displays the destination object, document % sy Riﬁzﬁ;‘: ?x::{lmsu;g:;t‘:;he ra:mge o
;};:E:;m. Edit — Repeat o cells to be added. If the suggested range is
Shorfouf _)I Cl+ K ] incorrect, drag through the range wou want,

= and then press ENTER

Displays a listi??u::t?;:::nd their — Sort Ascending
formats and allows you to set values for _ Sorts the selected items in order from the
arguments. % beginning of the alphabet, the lowest

number, or the earliest date, using the
column that contains the insertion point. If

Sort Descending E L you _previnusly set other sorting options are
Sorts the selected items in order from the / — ik effect, .
end of the alphabet, the highest mamber, or ABsaytive; Tabla — Sont —» Ascending
the highest date, using the column that
contains the insertion point. If you 8 Drawing
pre}';ouily set other sorting options are still F— Shows or hides the Drawing Toolbar,
in effec

Alternative: View — Toolbars — Drawing
Alternative: Table — Sort — Descending

Chartizard il
Starts the chart Wizard, which guides you
through the steps for creating an embedded
chart on a worksheet or modifying an
existing chart.
Alternative: View — Toolbars — Drawing

Microsoft Fxcel Help
Provides help topics and tips to accomplish : Zoom Control
your task. __@ Scales the editlingview (Zoom).
Alternative: Help — Microsoft Word Help Alfernative: View — Zoom
Shortcut — Fl ~
100% =

% The formula bar is the place in which you enter the
formula(=A3*B5)

[ 517 -] =

% The alphabets A,B... are known as columns
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% This is the name of the workbook. (Book1)
& Book1

= of o] 22 o {
»io Do |00~ OO (U (K=

14
% The rows are numbered as 1,2,3...

% Sheetl,Sheet2, Sheet3 are known as worksheet tabs

\Sheet1 / Sheet? / Sheet3 /

How to use Help Menu
% Click on Help, Contents and Index, then click on the Index

tab. The following screen will appear

About Microsoft Excel L

Micresoft® Office Excel 2003 (11,5612,5608)
Part of Microsoft Office Professional Edition 2003
Copyright @ 1985-2003 Microsaft Corporation, Al rights reserved,

& B potions of Inernational ComectSpel™ spaling comection system © 1933 by Lemout & Hauspée Speech
Products MA% All pahts meerved, Franch speling chatkar and dicionaties £ 19342000 SYNAPSE
Développemert; Taucuse (Francel. All rights reserved. Sparish Spelling Engine © 1998.2002 by
SIGHUM Cia, Ltda, Quita, Ecusdor. All nghts reserved,

This product is ficensed to:
eg

=g
Product 1D~ 73931-641 -3854546-57646

j View the End-User License Agresment

‘Warning: Thes computer program is protected by copyright law and internationsl

tresties, Unautharized reproducton or distribution of this program, of any portion of -

it, may resuk in severs civi and criminal penalties, and wil be prosecubed to the F

madmLm extent possitle under the .
Tech Support,.,
Disabied Items. .
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% Type the first few letters to see the help entries for those letters.

% You can get the printout of any help topic by selecting it, right
clicking and then clicking Print Topic.

Workbook Management
Task 1: Creating a new workbook

+ Click on File menu and then click on New.
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% Click Workbook and then click OK button. You will get the
screen as shown below.

MS Excel Page 7 of 40



& Microseft Excel - Book1

Typ=aquestonfor hefp = o 80X

RO e 0 P

¢ |

*,
"

.- x

Tepes a queston for hek

3

-

3

| Sales Report

Region January FebruaryMarch
North 6000 7000| 8000
7000 G800 7500
4000 5000 G000
5000 6500 8000

L1

East
West

—_

R

MS Excel

{74 bihsheets {Shesta { Sheetd /

4 start

¢

Page 8 of 40



Task 2: Saving Workbook

% Click on File menu and then click save. You will get the below

screen

Save As

72X

Save in: [@ Desktop v @2 |Q X [y 3 Tools~
A Name £ .
L..Q \f_JMy Docurnents
My Recent
Documents "‘ My Comptes
|| Sy Network Places
‘l“'.' [L_JAP DIST MAPS
- L_Japmaps b
Desktop __JAptitude Question papers
) C-Programs
\ _)DDM Books CDS
|C)Degree JKC
My Documents || (=) pistrict wise maps
. LJempnews
_ |JEnglishpapers
' [CFEP
My Computer || = -2008 v
- < >
File name: v [ save |
My Network b =
Places Save as bype! | microsaft Office Excel Workbook v | Cancel | J

< In the File name text box, type sample and then click Save

button

Task 3: Opening an existing workbook

% Click on the File menu and click on Open. The open dialog box

will appear

MS Excel
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Open @&]

Lockim: || Desklop v | 3 A Q X [y Tods~
5 E‘_‘MP DIST MAPS L Ipayment details @]ddﬁa’k.ﬂnartamr
\_._9 | apaps (_JPending maps '—'!_]] KakatryaMahiaDegreeCodeged, 3,200
My Recent || ) Aptiude Question papers (_JReasaning i?]r'.lcu-re;:.orted N Shudertsist(1)
Pocirrents ) C-Programs (schedules @jpr%wsh
e |{ZIDDM Books (DS [jsrisha @]smrtu to NO Details Calleges
B |)Degree e )50t Skills B8 s Bils(1)
Desktop | (L) District wis maps srilakshmi
| ) emprizws (JSRMT Files
| Engishpapers ) Tietabile
A S)TTsch
My Documents | (3KC 2008 Hooks Detals(1)(1)
| iLearning Resources @Bﬂuks CDs Format
q‘! (Sma %}Bouks& o5 detals
&) 5ymaps FinaL S Candidates selected for GENPACT
My Computer || psoffics ) Coleges List Incertives Received Letters()
i { >
" File name: || v
Py Metwark
Places Files of type: | Al Microsaft Office Excel Fles v Cancel }

% Click on some file (Example: sample.xls), then click on Open.

Task 4: Closing your workbook

*,
"

Click on File menu, then click Close to close your workbook

Cursor Management

Task 1: Moving around the worksheet

>,
"

*,
"

>,
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"
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Open sample.xls workbook.

Move the cursor in your worksheet by using the arrow keys on
the right-hand side of the keyboard.

When you have got lots of rows of data you can move the cursor
more quickly by using the PgUp and PgDn keys to move up and
down a screen at a time.

To move one screen to the right, press the Alt key and PgDn
keys together.

To move one screen to the left, press the Alt and PgUp keys
together.

To move further to the right, just keep pressing the right arrow
key

To move back to cell Al, press the Ctrl and Home keys
together.

Pressing the Home key on its own takes you back to column A
To move to the last column(IV) press the Ctrl and right arrow
keys together.
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% To move to last cell containing data, press Ctrl and End keys
together.

% To move to the last row(65,536), press Ctrl and the down
arrow keys together.

% You can also move the cursor with the mouse. Move the mouse
pointer to the location you want. Press and release the left
mouse button once when the cursor is where you want it.

Task 2: Moving to a Specified cell

% Click on the Edit menu, choose Go To. You will get the below
screen

Go To @@

Reference:

[ Special... ] i OK I[ Cancel ]

% Enter the destination cell reference in the Reference text box.
% Click OK to move directly to the specified cell.
Data Manipulation

Task 1: Entering data

% Start Excel. Click File and then New. An empty worksheet
appears as shown below
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% Type Expenditure in cell Al then press down arrow key to move
to cell A2.

% Type Month then press the down arrow key to move to cell A3

% Continue to type the data. The resulting worksheet should
appear like the following screen.
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B Microsolt Excal - Book?
FUlEe B Wew Dist Fowst Dok Debs Wodeo Heb

Type s vmshion bor e i B
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Expenditure
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Electricity 20 22
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% Save your work by clicking File and then Save As. This dialog

box appears.
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() C-Programs
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Places Save as type: | Microsoft Office Excel Warkbook

o o

% Type cash in the File Name text box and then click Save button.
Excel automatically adds the extension .xls to your file name.

MS Excel
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Task 2: Editing data

% Click File and then click Open.

% Click cash.xlIs and then click Open.

% Move the mouse pointer to cell D4, click and release. The cell is
highlighted and 18 appears in the formula bar.

% Move the mouse pointer to the formula bar and click once to the

right of 18.
B Microsofi Excel - Baok? A&
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T = FT]
A | B [ ¢ WO B | F | ¢ | H | #

1 Expenditure

2 Month Jan Feb Mar

3 Rent 200 200 200
4 |EBlectricity 20 22

5 |Household 150 145 150
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% Use the Backspace key to delete 8,then type 4 and press
Enter. Cell D4 now contains the value 14.

Task 3: Replacing cell data
% Make the cell B5 active by clicking on it.
% Type 200 and press Enter. The cell B5 will now contain the value
200 replacing old value (150).
Task 4: Deleting cell contents
% Move to cell C5 and click to select.

% Press the Delete key.
% The cell becomes blank.
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% Drop down the Edit menu and click Undo to reinstate the 145.
Excel 97 allows 16 levels of undo. You can use Undo and Redo
buttons also.

Task 5: Copying data

% Open the cash spreadsheet.

% Select the cells D3 to D5

% Click Edit menu and then click Copy.

% Select the cells F3 to F5.

% Click Edit menu and then click Paste.

% Now the cells D3 to D5 are copied into F3 to F5.

Task 6: Moving data

% Open cash.xls spreadsheet.

% Select the cells from B3 to B5.

% Click Edit menu and then click Cut.
% Select the cells G3 to G5.

% Click Edit menu and then click Paste.

Task 7: Data Auto Fill

There is an easy method to fill the data in columns and rows. The
data may be Numeric or dates and text.

To fill Sino by using auto fill
¢ Type Slno for 2 cells i.e 1,2 in the cells A1 and A2 respectively.
¢ Select two cells and drag the Fill Handle +

BNl = | c [ b [ E | F

1 1 2 3 4 5 6
2 2
3 3
4 4
5 5
6 6
8 8
9 9

To fill dates in the cells

MS Excel Page 15 of 40



¢ Type date in the cell
¢ Select the cell and drag the Fill Handle

A | B C D
101/01/2008 02/01/2008 03/01/2008 04/01/2008
02/01/2008

03/01/2008

104/01/2008

05/01/2008

106/01/2008

07/01/2008

08/01/2008

9 109/01/2008

10 | 10/01/2008

11 |11/01/2008 [ 1

—

N = w9

()}

1

o0

We can customize the lists with different text data to minimize the
redundancy of work.

Some of the lists are listed below:
1. Jan, Feb, Mar, Apr, May, June, July.... like months

2. Sunday, Monday, Tuesday, Wednesday, Thursday...Like week
days

3. Adilabad, Anatapur, Chittor, Cuddapah... like District names
4. Ravi, Kiran, Praveen, Rama.... like employees list
To create a customized list follow the steps given below:

¢ Click Tools Menu ,Click Options then click Custom Lists tab, Then
you will find the figure given below:
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Options

Color | International |  Save Error Checking
View | Calcuation | Edt | General | Transtion ||
Custom lists:

[NEw ST
| Sun, Mon, Tue, Wed, Thu, Fri, £
Sunday, Monday, Tuesday, Wet
Jan, Feb, Mar, Apr, May, Jun, ]
January, February, March, April

List entries:

Press Enter to separate list entries.
Import list from cells:

= )

[ O ] [ Cancel

¢ Click NEW LIST and enter the list in the List entries window

¢ Click Add button then click OK button then your list will be
added to the Custom Lists. That list you can use as and when
required to type.

¢ Now you can Drag the fill handle (+ ) to get the
automatically.

list
Using Formulae and Functions

Task 1: Entering a formulae

% Click File and then click New.

By

% Enter the data in the new worksheet as shown below
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[2] fie TAE M dneer Prmes  Tads Deba wieow len
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A WECEN c D ["®m [ F G H [ ®

LT Electricity

2 |Menth Tan Feb har Apr My Juan

3 |Rent 2000 200 200 250 300} 250

4 |Electricity 20 22 158 25 30 28
5 |Household 150 145 150 130 150 140
L & |Power

8

9

10

11

12

13

14
n‘l.';‘ W Sheotl ¢ Shoots f Sncots [/ ] o
Reniy_

TR0 b et T

= L

% Cell B6 should contain formula. Move the cell pointer to cell B6.
% Type =B3+B5(formulae and functions should always begin with

= sign)
< Cell B6 will now contain the value 350

% Look at cell B6; you will see the result of the formula in the cell

B6 rather than formula.
% Now repeat the appropriate formula for cell C6, D6.
% Save your worksheet as cash3.xls.

Task 2: Editing Formulae

% Move the cursor to the formula bar with the mouse, clicking

once.
% Make the desired changes.

% When you have finished editing the formulae, press the Enter

key for the changes to take effect.
(OR)

% Edit the contents by pressing F2 key on the keyboard

Task 3: Displaying and Printing formulae

% Click Tools menu and then click Options.
% Click View tab.

< In Window options check Formulas check box. The below

screen appears.

MS Excel
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Options

| Color | International | . Save  Error Checking Speling | Security |

Yiew I * Calculation | Edt | General | Transition [ Custom Lists | Chart |
Show

Startup Task Pane Formula bar Status bar Windows in Taskbar
Comments

() Mone & Comment indicator only ) Comment & indicator
Objects

() Show all () show placeholders ) Hide all
Window options

[]Page breaks Row & column headers Horizontal scroll bar

______ Outline symbols Vertical scroll bar

Gridiines Zero values Sheet tabs

Gridlines color: . Automatic v

OK I [ Cancel J

% Click OK button.

% To print the worksheet with formulae displayed, click File menu
and click on Print Preview. If the layout is satisfactory, click on
the Print button.

Task 4: Using the SUM function

% Open cash3.xls spreadsheet.

) microsedl [ened - Dackt

FAL EW B e et fpwe [ods e s (a = P
A A g 2 20 K& B F 0 .r &t'ﬁl.ii_ﬂh}_]-‘t’-'ull;{‘4 o |
flrmtantoren =10 /B 7 G IE BB S %+t 3 wm oo A-Biooiol SISl o '}
[+~ O LG 0 reeram s gne | T beoki E e
Piawas o Agosbepses s s ol M 8Ll ey p-mmEd d)
= | - . ] ; ) R
A B | C D E F | G H a
' Electncity
2 AMAlonth Jan Feb M lar A Miav Jun
3 Rent 204 200 20H} 230 300 230
4 Electrcity 20 23 I8 25 30 28
5 Household 150 145 150 130 150 | 40

6 Power

% Suppose if you want the summation of the cells B3 to B5 should
appear in the cell B6, then first select the cells from B3 to B6.
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Click the Auto Sum ﬂ icon on the toolbar.
% The result of (B3+B4+B5) will appear in the cell B6.

Task 4: Copying Formulae

% Open cash3.xls spreadsheet.

If you want to copy the formula in the cell B6 to C6,D6,E6 then
first select the cell B6.

% Move the cursor to the lower right corner of the cell B6. The
cursor will change to + icon.

% Drag the cursor from B6 to E6 and release left mouse button.

% You will notice that the cells C6, D6 and E6 are updated
immediately as shown below.

>,
"

B3 Microsoft Excel - Book1 =G
FAY Ble Bt Vew et Fomet  Took Daba Widow Hel hep o B %
BN RN NI - A SR R R A AR RS TS | 3 T P S !

ETinesNewRomen = 10 = | B F 0 BB = ow] § %o v S |- - A g .‘fwxem;" s v | 5 E
1) G &) Faveriteg - | G | 5 | Hocka ﬂk =
Loy - b S S.CLO o Az @l g A==l
= £ =SUM(EIBS)
_~%\|B|C|D|E|F|G|H|_?
1
2 Month Tan Feb Mar Apr May Tun
3 Rent 200 200 200 250 300 250
| 4 Electricity 20 22 18 25| 30 28|
| 5 HouseHold 150 145 150 130 150 140
6 |Power | 370 367 368 405 480 418
=
8 4
9
10
1
12|
i3 |
14
W< i\ sheet1 (sheste { Shests / J¢ sl
Ready LM

") Prits - Microssit Word

Task 5: Copying formulae using absolute addressing

+ Create the worksheet shown below and save ABS
% If you copy the formula in the cell c2 to c3, c4, c5 you
the incorrect

will get
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B micrasott Freal - ookl

] P Bkl Wk Dimerl Funel G Gule Wik badp Typea uesionforhels =@
ST TIPS ST PR R T uﬁ it 12l
T e TR L [ T T e Ty e MEmrr e B
i B G ) everbes | Gon [ [T [ Bkt =
i Do figtethapes - O o e P B N N[ [ N, AP Y S i :&g"jl

3 I _R;"'_ﬂmmq,

A | B [T e | o | B | F ¢ | H | =

1 MNet Price Total Price
2 [ sas|=por@2"r9)
3 5.89
3 I ars
5 7 AT
(&}
8 |WVAT Rate

_ 0.265]

W unttea ) Rk

> result because the formula WI|| change in the cell (C3)to BB*AlO
but the value in the A10 is not defined. The reason is that we are
copying relative address but not absolute address. To use
absolute address move to c2 cell.

% Edit the formula to =B2+($B$2*$A%$9) and press Enter key.
% Copy the formula to cells C3 to C5.

= Micrasaft Fxcal - Roakl

JLﬂwmmwwmmmm Ty
% T B e e e !!Jﬁjm’* s i e
13 Tmes Hew Kemen -m.n:g|,. =t st amae oo AR e ol S
EiEagaia i W) revorkes - gar | T | EBoakd v

D ; ’gknﬂxg-ﬁ _\_%L:]D e M, S-S NI R S - S e | Ja D

A | B | e | o N F | ¢ | H# |3

1 Met Price Total Price
2 645 8. 15925
3 589  7.59925
<4 4.78 6. 48925
5 7.47 917925

[ it

WAT Rate
9 0265
5 265 | | —
11
12
13

14

I i »i' Sheetl ¢ Sheei { Shasta / ) I x

= W © [ Dhneear et [T P e Wi

Formatting Spreadsheet
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Taskl: Increasing column width

% Open an existing worksheet(For example cash3.xls

B Microsoft Excel Hook?

D) pte [dE Mew Inemt  Former Zocls Dats dndon  pels T
FRWE N - MO TP NN X o - e [N TR T I EH RS i |
TrecHewRomen = 10 - B L O :I:ﬁ':? 3 Gl M| TR - e AW g =g ey a5 g
e e e et s M e -2
_E_n_lu-w-qlmnmhm--\\l_lQ_J-dr“'nﬁLﬂ G- A= @ a R

__A___BIC_DIE_F_G_HIJ'%
1 |Expenditure
2 |honth Jan Feb Nar Apr May Jun
3 |[Rent 200 200 200 250 300 250
4 |Electricity 20 22 15 25 30 28
5 |Househol 150 145 150 130 150 140
G | power 370 367 368 405
7 :I
&
9
10
11
12
13
14
L= -

Ready RIUM

F2R-Prires - PaErasatt Wit & - Lnttiad - Fari

*,

% Move the mouse pointer to the position(column B)shown below
in the column header. When the black cross appears, hold down
the left button and drag the mouse to the right to increase the
column width by the required amount.

"_'IDW At dme  greas Cgmat Teoke  Gare Ddcdoe e Tt b T i E—
g bl 3 ootio b n | ST e D [T WhE 8 ;u- s e -3 -
Fornan S 10 = W or W e e e | S 2 caf SR | wee we o - e O W W e ey | B
__4|_n_-;.-w.w e ] =
¥ P o =T I T T N R Sp = W 0 |
e = )
A B e 1 = | P =
1 T=penditure
2 [ hdonth JUESTRY Fels Loy Mo Mlay
3 Rent 2O 2000 =00 250 3
'l Electrieity 20 222 1= b E 1
| TTouschold 1 50y 145 150 1 300 1 5¢
!P““ e1 370 a7 a8 —IOSI

Task 2: Decreasing column width
% Open cash3.xls spreadsheet.
% Move the mouse pointer to the column B. When the black cross
appears, hold down the left button and drag the mouse to the
left to reduce the cell width.

Task 3: Changing width of all cells in a spreadsheet
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% Open cash3.xls spreadsheet

% Select the entire worksheet by clicking the Select All button (to
the left of Al cell) at the top left corner of the worksheet. The
worksheet changes from white to black.

B2 Microsoft Excel - Book2 [= |
He] gie Ede  wew Insert  Format Iook  Date  Window  Hel Tpea quastion for bk SEESERIE:

P 3 A B T N e A0 s B - R Sz ~ e B o S |
ITmeshewRoman - 10 | B F U | === 8§ % 98 | 2 et iaszasi s y iy g i
fig A2 | 6 & Faverkes= | Go= | 7] | Bookz __-B
ibrew i [ Aueshopes= N 1O =] Al € (@ 0 O - '
Al - A Exponditure
A | B | & | »p | B | ® =
I |Expenditure
2 [Month Jan Feb MNar Apr May
3 [Rent 200 200 200 250 300
4 [Electricity 20 22 18 25 3(
5 |[Household 150 L45 150 130 15(
6 [power 370 367 368 405
5
S
9
10
11
12
13
14
“1.::_ u i\ Sheetl § Sheet? f Shesta [/ |< g

Peady ‘Sum=3918 H_

Y mso=celz - Microsoft ... 5§ Ppnts - Mcrasoft Word i umititled - Pant

% Click Format menu, click Column, then click Width

% In the column width text box type 20, then click OK button. Your
worksheet cells should all increase in width.

Column Width 3

Column width:

[ OK ][ Cancel ]

% You will get the below screen. You will notice that widths of all
columns are now changes to 20
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3 Rent 200 200 200
4 |Electricity 20) 22| 18
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=
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=
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% Click the Undo button to revert to the previous cell width.

Task 3: Inserting Columns

% Open cash.xls spreadsheet.

% Move to cell B2 and click.

% Click Insert menu,
screen.

B3 Microsoft Fxcol - Honk?

click Columns. You will get the below

Type aquemicritor hele = 3

ety

H‘_]qh Bt U leert Fomel Lods ua\a nde  tep
= |'.7-| -;lvz-m 1@ = -2l xl ) s = @it 2 |
LS £ | i1 : HFE= 0. .. W] a
E | ¥=
| Expenditure
2 |[Month | |7an Feb Mar Apr
3 |Rent 200 200 200
| |Electricity | 20| 22 18
5 |Household 150 145 150
6 |power 370 367 368
= | I |
8
9
10
11
12
13
14
' snestt (o £ hasts 7 I« ! i
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% A blank column will be inserted before(to the left of column B)
Task 4: Deleting Column contents

% Open cash.xls spreadsheet.

% Move the mouse pointer to column E header and click to select

column E
&

Jan

'JJ‘I\J’r—-

| <10 |wn |+

enditure

Mar

200

18
150
368

% Press Delete button. The column contents will be deleted.
% Click Undo button to revert to the previous screen.

Task 5: Removing columns, rows, and cells completely

+ Select individual columns or rows or cells.

+ Click Edit menu and click Delete

Task 6: Inserting a row

130
405

% When you insert a row, it is inserted above the current row, so if
you want to insert a new row above row 6(between rows 5 and
6), place the cursor on a cell in row 6 and

+ Click on the Insert menu.

4 Click Entire Rows insert a blank row between rows 5 and 6.

Task 7: Deleting row contents

% Open cash.xls spreadsheet.

% Move the mouse pointer to row 2 header and click to select the
row as shown below
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% Press Delete to remove the contents of row.
% Click the Undo button to cancel the delete operation.

Task 7: Inserting cells

% Open cash.xls spreadsheet.
% Select cells B2 to D4 by moving the mouse pointer to cell B2,
holding down the left mouse button and dragging the mouse

pointer to cell D4, then releasing the left button. The cells should
be highlighted.

S microsoft fxcel  Boak?
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% Click Insert menu and click Cells. This dialog box appears.
% Click OK to shift the cell down.
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Insert

Insert
) shift cells right
() Shift cells down!

) Entire row

() Entire column

[ OK ] [ Cancel ]

Task 8: Changing data justification

% Open cash.xls spreadsheet.

% Select the cell B2 as shown below.

% Here the text “Jan” by default left justified. You can modify
alignment as right justified or center by clicking right justify

or center the text =
within the cell by clicking respectively.

Task 9: Merge and Center data

% Open cash.xls spreadsheet.
+ Select the cells A1 to H1 as shown below

e A B C D E F G H
2 |Month Jan Feb Mar

13 |Rent 200 200 200

4 |Electricity 20 22 18

' 5 |Household 150 145 150

)

% Click Merge and Center button on the toolbar

% You will get the below screen.

A | B | ¢ | o | B [ F | 6 | H
Expenditure
Month Jan Feb Mar
Rent 200 200 200
Electricity 20 22 18
Household 150 145 150
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Task 10: Formatting cells

A B | ¢ | b

Marks
200 66.66666667
440 2222222222
640 213.3333333

-4|m‘o~. #‘wlm‘_‘

% Create a new spreadsheet as shown below and save it as
“marks.xls”

% Now you can format the cells in column C by selecting column C
by clicking on the column heading

{Number || Alignment | Font | Border | Patterns | Protection |
Category: Sample

Jan
Number
Currency
Accounting
Date
Time
Percentage
Fraction
Scientific
Text
Special

| Custom

General format cells have no
specific number Format,

[ OK ] [ Cancel

+ Click Format menu and click on Cells. Click on Number.

4 Use the Down arrow in the Decimal Places to set to 0. Click
OK.

% Now repeat the formatting but this time format the cells to two
decimal places.
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